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Purpose of this document?

This document is designed for administrators or power users of SalesOutlook that want to create or edit existing reports within SalesOutlook.  All aspects of using, configuring and customizing the SalesOutlookReports interface is covered in this document.  End users who simply want to run pre-defined reports using the Print Reports button should refer to the SalesOutlook Users Guide.

ODBC-Compliant Report Writer 

SalesOutlook 4.1.x changed the ODBC setting from a System DSN to a User DSN. The location of the SalesOutlookReports.mdb has changed location from Program files\SalesOutlook to {username}\Application Data\SalesOutlook.  The SalesOutlook reports are not affected and will run as normal as long as the reports are defined using the SalesOutlook Reports User DSN.
System Requirements

Please refer to the SalesOutlook – System Requirements document for details regarding minimum and recommended system configurations.
SUPPORTED VERSIONS:  You can use up to Crystal Reports XI full runtime functionality. 
Configuring the SalesOutlookReports ODBC System Data Source
Note: The SalesOutlookReports ODBC User DSN is automatically created when SalesOutlook is installed.  However, it  must exist on each computer that will author or execute reports using the SalesOutlook Reporting Engine.  The next few steps are for troubleshooting purposes only.
In order for the reports you create to function properly on every PC in your organization, it is important that the reports are designed so that they use the ODBC User Data Source Name of ‘SalesOutlookReports’. This User Data Source Name is automatically created during the installation of SalesOutlook 4.1.x and later. 

The instructions provided below will walk you through verifying the existence of and/or creating the SalesOutlookReports ODBC User DSN. 

To verify the existence of the SalesOutlookReports ODBC User Data Source Name, or to manually create and/or configure the ODBC User Data Source Name, complete the steps outlined in the following sections on each computer running the SalesOutlook software that will also author or execute SalesOutlook Reports.

Verify the Existence of the SalesOutlookReports ODBC User DSN
1. In Windows, click the Start Button and select the Control Panel applet from the Settings menu option. Click on the Control Panel applet to open it.
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2. In Control Panel, locate the Data Sources (ODBC) icon and double-click it to open the ODBC Data Source Administrator window. 
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Navigation Tip:  The ODBC Data Sources icon and its location are different for different versions of the Windows operating system. For example, in Windows 2000 the icon is called Data Sources (ODBC) and is located within the Administrative Tools applet of the Control Panel. Double-click the Administrative Tools icon to display the Windows 2000 Administrative Tools, including the Data Sources (ODBC) icon.
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3. After opening the ODBC Data Source Administrator window, click on the User DSN tab to display the list of ODBC User Data Source Names defined for the computer.
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4. Verify that the entry named SalesOutlookReports appears in the list of ODBC User Data Source Names. If it does, verify that it correctly specifies the Microsoft Access Driver (*.mdb) database driver and that the data source definition points to the SalesOutlookReports.mdb located in the user’s Windows Profile in the Application Data\SalesOutlook folder.  If the default settings were used when SalesOutlook was initially installed, then the SalesOutlookReports.mdb resides in the {username}\Application Data\SalesOutlook\ folder.
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5. If the SalesOutlookReports ODBC User Data Source Name exists and is configured to point to the SalesOutlookReports.mdb in the SalesOutlook Program Files folder, the computer is properly configured to author or execute SalesOutlook Reports.  If not, please Add the and Configure the SalesOutlookReports ODBC User DSN with the above information.
Using the User Data Source Name for SalesOutlook Reports

Reports that use the ODBC User Data Source Name of SalesOutlookReports have two distinct advantages over reports that are designed to use the SalesOutlookReports.mdb or Outlook/Exchange folders directly.

First, reports that are authored to use the ODBC User DSN of SalesOutlookReports can be distributed and executed on any computer that has SalesOutlook installed on it and an ODBC User Data Source Name definition for SalesOutlookReports. This resolves the issue of reports generating errors when being ran by users that have installed SalesOutlook to alternate drive and folder locations.

Second, the drivers provided by Microsoft (and used by Crystal) to extract data from Outlook and/or Exchange folders does not handle date type fields correctly.  Using an ODBC User DSN resolves this issue so that date type fields are handled correctly.  SalesOutlook Reports extends the native Microsoft ISAM and OLEDB technology to provide you with a robust, ODBC-based query interface to the SalesOutlook data.
SalesOutlook requires that every report you define and/or use that incorporates data from your SalesOutlook system uses the ODBC User DSN of SalesOutlookReports to eliminate / workaround the issues described above.  Also note that Outlook must be running in order for the ODBC link to be able to gather information stored within Outlook.
To create and/or modify reports so that they correctly use the ODBC User DSN of SalesOutlookReports, please refer to the help provided with the application you are using to determine how to specify an ODBC Data Source Name.   In Crystal Reports, be sure to set the configuration option to “Show Synonyms” (and the equivalent setting in other programs to display “Aliases” or “Linked Tables” in order to see the SalesOutlookReports linked folder Tables in your reporting and/or query tool.
Creating Reports

Crystal Reports

1. Open Crystal Reports.  Once open, create a NEW report by using the Report Expert, or select to Open an Existing Report.
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2. When creating a new Crystal report using the Report Expert, a Seagate Crystal Report Gallery screen appears prompting you to choose a format for your new report.  Once you select the desired expert format, click OK.

[image: image7.png]Seagate Crystal Report Gallery

Create a New Ciystal Report Document

], Using e Fepn Espet

D s aBlank fieport

Chase an Exper

) Standad
Do Lot
@ om

Mo b

et

ot Lol
o Doun
Eloue

Guides the creation of & val:&hevmt

Cwesl |t




            

3. Click on Database.  Within the Data Explorer, expand “ODBC”. 

[image: image8.png]B Standard Report Expert

Deta | ikt | Goue | Tt | Top | Ghat | Soect| s |
e

Clck Database 1o open a database file or data server.
Cick Ciystal ST Quety or Ciystal Dictionary i your data s aheady saved in one o these two fomats

Tables avaiabl fo repat

) Data Explorer

Database

ity a b

3 Create New Data Source Berove

i3 Connect Using Fie Dt Source

8 CRRMLY3S S| AddtoFavartes
9 dBASE Fies
vcelFies Delete Fevorie

9 MS Acosss Database L
@ SalesOullackReparts

9 Seme Sample Database

1 FADatabase Fiks L]

I

_Ocsn s | Froven e | Iy
B e s oo

P e P A D) e

toadd C o ]

Cysal SOL Query

[ v





4. Navigate to “SalesOutlookReports” and expand by clicking the plus sign.
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NOTE:  The folder names should NOT contain the word SCHEMA.  To remove Schema from the folder name, click the Options button and check the box for “Synonyms”.  If you change these settings then you will have to collapse and expand the SalesOutlookReports ODBC setting to see the changes.
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5. Select the Folder(s) associated with the fields you want to report on in regards to this report.  In the examples below we selected the Account Profiles and Opportunities folders.  Click the Add button after selecting the desired folders.  The folders will display within the Standard Report Expert window.  Then click Close within the Data Explorer window.  You can select multiple folders by using the Control key. 

[image: image11.png]5 @ SelesDulookRepots  a] Add

‘Accout Contacts

Actions

8 Docurens o

Drop Downs _—
AT e Pt

Mailings D

- Data Exploer
Biowse thiouh the folders o find your data source's oo
tables. Select and Add tables thal contain daa you Heb

wan 1o teport on. You oan aso double-cic a table:

.





6. If you chose more than one folder then you should link the folders by the Primary key. The Primary key is noted with a red arrow located within the Links tab of the Standard Report Expert.  Linking tables is important, as it is needed to match records from one table with corresponding records of another table.  Click and drag the red arrow link to the other table with the same ID (key) field.  A white line displays between the 2 tables once the common fields are linked.  

TIP: To improve run-time performance for reports that incorporate data from multiple SalesOutlook folders consider designing sub-reports to gather the data and a master report to combine the sub-reports into a single compiled report.  You then pass parameters to the sub-reports to filter the contents as desired.
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7. Within the Fields tab of the Standard Report Expert, select the fields you want to add to the report.  You can add fields by simply clicking on a field within the left column and dragging it over to the right column.  You can also use the Add button.  If you need to remove a field from the report, click on the field from the right side of the column and then click the Remove button.  
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8. Within the Group tab of the Standard Report Expert, select the field(s) you want to Group By for the report.  As with adding fields, you can group fields by simply clicking on a field within the left column and dragging it over to the right column or by using the Add button.  The fields listed under the “Report Fields” are the fields you selected to display within your report. 
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9. Within the Total tab of the Standard Report Expert, select the field(s) you want to total for the report following the same selection process as above.  You have the ability to select the type of summary to calculate for each field selected.  
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10. Within the Select tab of the Standard Report Expert, select the field(s) you want to use to filter the data displayed within the report.  Based on the data selected, additional dropdowns appear to further define your filtering criteria for this report.  
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11. Within the Style tab of the Standard Report Expert, you have the option to select a certain style for how data is displayed within the report.  Within this tab you also have the ability to add a title and picture to the report.  Select any remaining criteria desired and then run the report.  Our report example is displayed below. 
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12. To incorporate your custom report into SalesOutlook, select File / Summary Info from the toolbar.


[image: image18.png]



13. Information placed within the Document Properties window will reside within the SalesOutlook Report Selection screen.
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Specifically, text placed within the Comments field will display on the right side (report description) and the Title will display on the left side of this screen (report name).

[image: image20.png]SalesOutlook Report Selection B

Select  report template fom the Reeport Templates st bos. Execte the report by clicking
the Run Riepart cammand bultan below. A dssciption of the epat s dsplayed aiving
basic informalion abaut the repot corterts.

Report Templates Report Description

[Activy by Date ange [5alesOulookReportl ipt Show Activs by Date Range
ctiviyfor this Morth (S lesDutlook Repots]pt
CalLog by Date Range (SalesDutlookFieports) ot
Forecast by Date Range (SalesDulookRepots]pt
Forecast ot the newt 30 days (SalesDutlookReports
kellest ipt

Curent Root Folder: ~ SalesOuock ver 35{@5 lesDutlook @
Data Map: Generated 5/6/2003 62312 PM

Fun Report Close. Map SalesDutiook Data





NOTE:  We choose not to use 2 tabs when building this sample Crystal report using the Report Expert -- the Top N and Chart tabs.  

· The Top N tab allows you to sort and group by a certain criteria.

· The Chart tab allows you to insert a graph or chart.

Developers should refer to the Crystal reports manual or go to http://www.seagatesoftware.com for additional information on building Crystal reports.

Excel Reports

Ad-Hoc Queries, Pivot Tables, Charts and Exporting Data Using Excel
The section below describes how to use the SalesOutlookReports ODBC User DSN with Microsoft Office applications, and more precisely, with the database query features of Microsoft Excel.  

TIP:  The same techniques can be used with other Office applications and software products that can access the SalesOutlookReports ODBC User Data Source Name, but the actual steps will vary from application to application.
You can import SalesOutlook data into Excel to create a variety of reports with features such as Pivot Tables, Charts, Summaries, and Tables.  The following example will walk you through creating a query in Excel that extracts SalesOutlook data and puts it into Excel for further “what if” analysis:  

1. Open Microsoft Excel.  Be sure you’re at a place to create a new worksheet or workbook.

2. From the Toolbar, select Data | Get External Data | New Database Query if you use Excel 2000, or select Data | Import External Data | New Database Query if you use Excel XP (2002) or later.
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3. Choose the SalesOutlookReports data source name and click OK.
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5.  Choose the fields you want to display on the report and click Next.

NOTE:  Selecting multiple tables/folders is allowed so long as the same field exists in both Tables/Folders and you have the Microsoft Query components installed so that you are able to edit the query and link the tables together using a common ID (key) field.

For example, it is possible to select fields from the Account, Account Contact, and the Opportunity folders within the same report since the AccountID exists in the Account, Account Contact and Opportunity folders and since the ContactID exists in both the Account Contact and the Opportunity folders.  If you do not define the correct relationships between tables your report will not produce the expected (correct) results.
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If you select data from more than one Table/Folder, then you will be warned that you must create the relationships, and the Microsoft Query interface will open automatically to enable you to build complex queries or refine simple ones.
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NOTE: See the Fields on the forms for reporting section toward the end of this document for a “map” of the SalesOutlook form labels to the corresponding names of the underlying Outlook fields.  An Entity Relationship Diagram (ERD) is included at the end of this document to help you determine the relationships used by the SalesOutlook data store.
6 Optional: Filter the data and set the desired options for the report by clicking the Options button, or edit the query with Microsoft Query by clicking the Edit Query button. You can also save the query if you like by selecting the Save As menu option on the File menu within Microsoft Query.

NOTE: If you selected fields from more than one table/folder then you will receive a warning message that the query wizard is unable to join the two tables because a relationship does not exist.  In this case, Microsoft Query will open automatically once you click OK on the warning message.  You can create a join between the two tables by dragging the Primary Key field from the Parent table and dropping the field on corresponding Foreign Key field of the Child table as shown in the following two images.
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7. Edit your query as desired and select the Return Data to Microsoft Excel option found on the File menu of Microsoft Query.
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8. Select the location in the Excel workbook where you would like to return the resulting data.
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9. Click the Properties button to name your query and define the output range (Named Range in Excel). In the Properties dialog, select the options that are most appropriate for the report you’re designing. If you would like to create a Pivot Table of your data, click the Create a Pivot Table Report link now.  Review the section “Creating Pivot Charts and Tables” noted later in this document for further details on creating Pivot tables.
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10. You can then use the features of Excel to modify your query results, create a chart, or print/email the workbook. A few examples are shown below.

	Sorting Data
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Filtering Data
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Sample Excel Report – Example Results

Before filter/sort is applied
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After filter/sort applied
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Optional: Adding Subtotals

From the toolbar, select Data |Subtotals |Total by Account Manager | Sum Total Purchase
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Creating Pivot Charts and Tables

1. Open Microsoft Excel.  Be sure you’re at a place to create a new worksheet or workbook.

2. From the toolbar, select Data | PivotTable and PivotChart Report.

NOTE:  If you already linked your database using the Ad-Hoc Excel Reporting it is not necessary to perform the steps listed to link your database.  Start with instruction # 12 to begin building the PivotTable.
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3. Select the radio button for “External data source” for the data you want to analyze.  You will also need to select whether to create a PivotTable or PivotChart (with Pivot Table).
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4. Click the “Get Data” button to extract your external data.

[image: image39.png]PivotTable and PivotChart Wizard - Step 20f 3 2%

Where s your external data stored?

ot ks hve b rttved

& N T





5. Choose SalesOutlookReports and click OK.
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6. Choose the fields you want to display on the report and click Next.

NOTE:  Selecting multiple tables/folders is permissible so long as the same field exists in both Tables/Folders and you have the Microsoft Query components installed so that you are able to edit the query and link the tables together using a common ID field.

For example, it is possible to select fields from the Account, Account Contact, and the Opportunity folders within the same report since the AccountID exists in the Account, Account Contact and Opportunity folders and since the ContactID exists in both the Account Contact and the Opportunity folders.  If you do not define the correct relationships between tables your report will not produce the expected (correct) results.  Refer to Appendix B appearing at the end of this document for an Entity Relationship Diagram (ERD) that will help you determine how to link the various SalesOutlook tables.
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If you select data from more than one Table/Folder, then you will be warned that you must create the relationships and the Microsoft Query interface will open automatically to enable you to build complex queries or refine simple ones.
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NOTE: See the Fields on the forms for reporting section below for a “map” of the SalesOutlook form labels to the corresponding names of the underlying Outlook fields.

8. Optional: Filter the data and set the desired options for the report by clicking the Options button, or edit the query with Microsoft Query by clicking the Edit Query button. You can also save the query if you like by selecting the Save As menu option on the File menu within Microsoft Query.

9. Optional:  Sort the data and select the desired options for the order of the data.

10. Click the radio button “Return Data to Microsoft Excel” when prompted what to do next.  
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11. After selecting Finish, a message appears that the data fields have been retrieved.  Click Finish again to view the fields and data. 
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12. A blank pivot table appears for which we must decide how to view the data.
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13. Construct your PivotTable by dragging the fields on the right to the diagram on the left.  The “Drop Page Fields Here” area is used as a filter for the entire PivotTable.  Consider an example of a Sales Forecast Report, one might put Account Manager so one could sort by specific territories or view all territories.

14. The “Drop Column Fields Here” area is where one drops the data that one would like to see down the side of the table.  For example, Probability.

15. The “Drop Row Fields Here” area is where one drops the column headers.  For example, Account Manager.

16. The “Drop Data Fields Here” area is where one drops the data one would like to see in the report.  For example, Forecast Amount.

NOTE:  For further information concerning PivotTables, consult Microsoft Excel or other resources since PivotTables and PivotCharts are functions of Microsoft.   
Distributing Reports

Crystal Reports

1. Copy the Crystal reports (rpt file) into the SalesOutlook Folder. Make sure the extension of rpt is visible before copying the reports to the SalesOutlook folder.
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2. SalesOutlook will automatically recognize the new Crystal report and load it into the Print SalesOutlook Reports window.
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Excel Reports

Copy your custom report to the Reports folder in SalesOutlook using Windows Explorer to enable other users to access the data within the Excel report.  Because of the way security information is stored, other users will not be able to refresh the data in an Excel report.  They will receive an error.  Only the original author may refresh the data.
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Modifying the SalesOutlook Reports Database

Note: Complete the steps in this section after you add, remove or modify the fields defined within the SalesOutlook folder structure.  The following procedure enables the SalesOutlook Reporting Engine to dynamically access the data contained in your custom fields when the report executes.
Add New Custom Fields or Folders
Administrator:

1. Add the custom fields in the folders and bind them to your SalesOutlook forms within the SalesOutlook directory structure per the best practices of Outlook Forms Design and according to the instructions provided in the SalesOutlook Administration Guide.
2. Publish the custom forms.

Update the SalesOutlookReports.mdb File with your Custom Fields

Click on Crystal Reports | Map Data button to get the custom fields into the schema. Note: The custom  field needs to be in the folder for the mapping process to find the field..
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All user will need to click on Map Data to get the custom fields mapped to their schema. Note: For reporting only. Custom fields will be automatically available to the user when you customize a form.

Appendix A: Fields on the forms used for reporting

Account Profile Form
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	Fieldname
	Form Name

	1
	Account Name
	Account Name

	2
	AccountNumbertxt
	Account Number

	3
	AccountAddress1
	Address

	4
	AccountCity
	City

	5
	AccountState
	State

	6
	Accountzip
	Zip Code

	7
	AccountCountry
	Country

	8
	AccountPhone
	Phone

	9
	Account Fax
	Fax

	10
	Account Web
	Web Site

	11
	Top25
	Top Account

	12
	Key Account
	Key Account

	13
	AccountCheckbox1
	Custom1

	14
	AccountCheckbox2
	Custom2

	15
	AccountType
	Type

	16
	Account Status
	Status

	17
	Account SIC
	SIC

	18
	Account Option
	Custom

	19
	Fiscal Year End
	Fiscal Year End

	20
	Account Parent
	Parent
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	Fieldname
	Form Name

	21
	Account Manager
	Assign to

	22
	Team
	Team

	23
	From
	Created By

	24
	Changed By
	Changed By

	25
	AccountID
	AccountID* Primary Key

	26
	Received
	Created

	27
	Modified
	Modified

	28
	Alignment
	Alignment
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	Fieldname
	Form Name

	29
	Custom1
	Custom1

	30
	Custom2
	Custom2

	31
	Custom3
	Custom3

	32
	Custom4
	Custom4

	33
	Custom5
	Custom5

	34
	Custom6
	Custom6

	35
	Custom7
	Custom7

	36
	Custom8
	Custom8

	37
	Custom9
	Custom9


The following are on the Account Profile form but are not shown.

	
	Fieldname
	Form Name

	38
	FROM
	Creator of the item

	39
	SUBJECT
	Account Name

	40
	BODY
	Associations Tab

	41
	Web Page
	Web Page

	42
	MESSAGE CLASS
	IPM.Post.SalesOutlook_2000

	43
	CREATED
	Date item created per store

	44
	MODIFIED
	Date item modified

	45
	Account LocationID
	Parent Account ID 

	46
	AccountNotes
	AccountNotes 

	47
	FormType
	FormType

	48
	In Folder
	Current Folder

	49
	Message
	Body of Account

	50
	Selected Item
	Current Radio Button

	51
	Selectedview
	Current view 


· Primary Key = Link to child objects

Account Contact Form
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	Fieldname
	Form Name

	1
	FULL NAME
	Full Name

	2
	Suffix
	Suffix

	3
	JOB TITLE
	Job Title

	4
	COMPANY
	Company

	5
	FILE AS
	File As

	6
	Contact Type
	Contact Type

	7
	Primary Contact
	Primary Contact

	8
	BUSINESS_TELEPHONE_NUMBER
	Business

	9
	BUSINESS2_TELEPHONE_NUMBER
	Business 2 

	10
	BUSINESS_FAX_NUMBER
	Business Fax

	11
	MOBILE_TELEPHONE_NUMBER
	Mobile

	12
	Contacts
	Contacts

	13
	Account Manager
	Assign To

	14
	Team
	Team

	15
	Message From Folder
	From

	16
	Message To Folder
	To

	17
	Address Selected
	Address

	18
	EMAIL1
	Email

	19
	EmailSearchString
	Email Search String

	20
	WEB PAGE
	Web Address


The following are on the Account Contacts form and may or may not be shown due to selection:

	
	Fieldname
	Form Name

	25
	DEPARTMENT_NAME
	Department

	26
	OFFICE_LOCATION
	Office

	27
	PROFESSION
	Profession

	28
	ASSISTANT
	Assistant’s Name

	29
	NICKNAME
	Nickname

	30
	SPOUSE_NAME
	Spouse’s name 

	31
	BIRTHDAY
	Birthday

	32
	WEDDING_ANNIVERSARY
	Anniversary

	33
	BODY
	Associations Tab

	34
	Categories
	Categories

	35
	SURNAME
	Last

	36
	MIDDLE_NAME
	Middle

	37
	GIVEN_NAME
	First

	38
	STREET_ADDRESS
	Street

	39
	POSTAL_ADDRESS
	Zip/Postal Code

	40
	LOCALITY
	City

	41
	STATE_OR_PROVINCE
	State/Province 

	42
	POSTAL_CODE
	Zip 

	43
	HOMEADDRESS
	Based on address pull down with selection as Home 

	44
	HOME_ADDRESS_STREET
	Street (Home)

	45
	HOME_ADDRESS_POST_OFFICE_BOX
	PO Box (Home)

	46
	HOME_ADDRESS_CITY
	City (Home)

	47
	HOME_ADDRESS_STATE_OR_PROVINCE
	State/Province (Home)

	48
	HOME_ADDRESS_POSTAL_CODE
	Zip/Postal Code (Home)

	49
	HOME_ADDRESS_COUNTRY
	Country (Home)

	50
	OTHERADDRESS
	Based on address pull down with selection as Other 

	51
	OTHER_ADDRESS_STREET
	Street (Other)

	52
	OTHER_ADDRESS_POST_OFFICE_BOX
	PO Box (Other)

	53
	OTHER_ADDRESS_CITY
	City (Other)

	54
	OTHER_ADDRESS_STATE_OR_PROVINCE
	State/Province (Other)

	55
	OTHER_ADDRESS_POSTAL_CODE
	Zip/Postal Code (Other)

	56
	OTHER_ADDRESS_COUNTRY
	Country (Other)

	57
	BUSINESSADDRESSSTREET
	Street (Business) 

	58
	BUSINESSADDRESSPOSTOFFICEBOX
	PO Box (Business)

	59
	BUSINESSADDRESSCITY
	City (Business)

	60
	BUSINESSADDRESSSTATE
	State/Province (Business)

	61
	BUSINESSADDRESSPOSTALCODE
	Zip/Postal Code (Business)

	62
	BUSINESS_ADDRESS_COUNTRY
	Country (Business) 

	63
	ASSISTANT_TELEPHONE_NUMBER
	Assistant (Based on telephone dropdown selection)

	64
	COMPANY_MAIN_PHONE_NUMBER
	Company (Based on telephone dropdown selection)

	65
	HOME_TELEPHONE_NUMBER
	Home (Based on telephone dropdown selection)

	66
	HOME2_TELEPHONE_NUMBER
	Home 2 (Based on telephone dropdown selection)

	67
	HOME_FAX_NUMBER
	Home Fax (Based on telephone dropdown selection)

	68
	OTHER_TELEPHONE_NUMBER
	Other (Based on telephone dropdown selection)

	60
	PRIMARY_FAX_NUMBER
	Primary Fax

	70
	PAGER_TELEPHONE_NUMBER
	Pager

	71
	PRIMARY_TELEPHONE_NUMBER
	Primary

	72
	FROM
	Creator of the item

	73
	TITLE
	Title

	74
	INITIALS
	

	75
	GENERATION
	Suffix

	76
	SUBJECT
	Account Name

	77
	BUSINESS_HOME_PAGE
	Email

	78
	EMAIL2
	Email 2 (Based on email dropdown selection)

	79
	EMAIL3
	Email 3 (Based on email dropdown selection)

	80
	Account Name
	Account Name

	81
	AccountType
	Account Type

	82
	Account Status
	Account Status

	83
	Account SIC
	Account SIC

	84
	Account Option
	Account Option

	85
	Top25
	Top25

	86
	Key Account
	Key Account

	87
	AccountCheckbox1
	Custom1 (Checkbox)

	88
	AccountCheckbox2
	Custom2 (Checkbox)

	89
	Custom1
	Custom1

	90
	Custom2
	Custom2

	91
	Custom3
	Custom3

	92
	Custom4
	Custom4

	93
	Custom5
	Custom5

	94
	Custom6
	Custom6

	95
	Custom7
	Custom7

	96
	Custom8
	Custom8

	97
	Custom9
	Custom9

	98
	Alignment
	Alignment

	99
	Selected Item
	Select A Folder

	100
	Selected View
	Selected A View


Note: The fields located on the Account Info tab of the Account Contact form are named the same and have the same labels as the 4 checkboxes, 4 drop downs and 9 custom text fields on the Account Profile form and are available on the Account Contact form in SalesOutlook 4.3 and later.

Opportunity Form
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	FieldName
	Form Name

	1
	Account Name
	Account

	2
	Account Owner
	Account Manager

	3
	Team
	Team

	4
	Name
	Name

	5
	Opportunity Type
	Type

	6
	Product
	Product

	7
	Lead Source
	Lead Source

	8
	Stage1
	Lead Qualified (Check box)

	9
	Stage1Date
	Lead Qualified (text)

	10
	Stage2
	Discovery Needs Analysis (check box)

	11
	Stage2Date
	Discovery Needs Analysis (text)

	12
	Stage3
	Product Presentation (check box)

	13
	Stage3Date
	Product Presentation (text)

	14
	Stage4
	Proposal (check box)

	15
	Stage4Date 
	Proposal (text)

	16
	Stage5
	Contract Signed (check box)

	17
	Stage5Date
	Contract Signed (text)

	18
	Stage6
	Opp Won Create Project (check box)

	19
	Stage6Date
	Opp Won Create Project (text)

	20
	TotalPurchase
	Total Opportunity Amount

	21
	Probability
	Probability

	22
	Opportunity Status
	Opportunity Status

	23
	Won/Lost
	Won/Lost Analysis

	24
	Competitor
	Competitor

	25
	Expected Close Date
	Expected Close Date

	26
	Actual Close Date
	Actual Close Date
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	Fieldname
	Form Name

	27
	ProjectStage1
	Kick Off (check box)

	28
	ProjectStage1Date 
	Kick Off (text)

	29
	ProjectStage2
	Analyze Requirements (check box)

	30
	ProjectStage2Date
	Analyze Requirements (text)

	31
	ProjectStage3
	Assign Project Tasks (check box)

	32
	ProjectStage3Date
	Assign Project Tasks (text)

	33
	ProjectStage4
	Customer Signoff (check box) 

	34
	ProjectStage4Date
	Customer Signoff (text)

	35
	ProjectStage5
	Install/Training Dates Set (check box)

	36
	ProjectStage5Date
	Install/Training Dates Set (text)

	37
	ProjectStage6
	Product Install Complete (check box)

	38
	ProjectStage6Date
	Product Install Complete (text)

	39
	ProjectCost
	Project Cost

	40
	Project Status
	Project Status

	41
	Reason for Delay
	Reasons for delay

	42
	Expected Project Close Date
	Expected Project Done

	43
	Actual Project Close Date
	Actual Close Date
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	Fieldname
	Form Name

	44
	Contact1
	Primary Contact

	45
	Contact2
	Secondary Contact

	46
	Contact3
	Manager Contact

	47
	Contact4
	Technical Contact

	48
	Contacts
	Contacts


The following are on the Opportunity form but are not shown:

	
	Fieldname
	Form Name

	49
	Account Manager
	Account Manager

	50
	Alignment
	Alignment

	51
	Division Manager
	Division Manager

	52
	Account Name
	Account Name

	53
	Accountzip
	Accountzip

	54
	AccountID
	Account ID

	55
	ContactID
	Contact ID

	56
	OppID
	Opportunity ID* Primary Key

	57
	Team
	Team

	58
	RegionNumberTxt
	Region

	59
	DivisionNumberTxt
	Division

	60
	TerritoryNumberTxt
	Territory

	61
	BODY
	Associations Tab

	62
	CREATED
	Date item created per store

	63
	FROM
	Creator of the item

	64
	MESSAGE CLASS
	IPM.Post.Opportunity

	65
	MODIFIED
	Date item modified

	66
	Product Group
	Product Group (related to Product)

	67
	Received
	Date item received

	68
	Selected Item 
	Current Radio Button


Note Form
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	Fieldname
	Form Name

	1
	Type
	Note Type

	2
	Subject
	Note

	3
	Contact Name
	Contact Name

	4
	Account Name
	Account Name 

	5
	Account Manager
	Account Manager

	6
	Team
	Team

	7
	BODY
	(Body of Note)

	8
	Categories
	Categories


The following are on the Note form but are not shown:

	
	Fieldname
	Form Name

	8
	Alignment
	Alignment

	9
	Alignment1
	Alighnment1

	10
	Alignment2
	Alignment2

	11
	Alignment3
	Alignment3

	12
	Alignment4
	Alignment4

	13
	Alignment5
	Alignment5

	14
	NoteCategory
	NoteCategory

	15
	AccountID
	Account ID

	16
	ContactID
	Contact ID

	17
	OppID
	Opportunity ID

	18
	Note Type
	Note Type

	19
	CREATED
	Date item created per store

	20
	FROM
	Creator of the item

	21
	Message
	Body of Note

	22
	MESSAGE CLASS
	IPM.Post.Note

	23
	MODIFIED
	Date item modified


Customer Service Form 
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	Fieldname
	Form Name

	1
	Account Name
	Account

	2
	Inquiry Type
	Inquiry Type

	3
	Assign To
	Assign To

	4
	Contact Name
	Contact

	5
	BusinessPhone
	Phone

	6
	BusinessFax
	Fax

	7
	InquiryPriority
	Priority

	8
	InquiryStatus
	Status

	9
	Knowledge Base Article
	Knowledge Base Article

	10
	Inquiry ID
	(blank)

	11
	Date Resolved
	Resolve Date

	12
	Created
	Create Date

	13
	Account Manager
	Account Manager

	14
	Team
	Team

	15
	Total Time
	Total Time

	16
	Subject
	Problem Description

	17
	BODY
	Problem Resolution


The following are on the Note form but are not shown:

	
	Fieldname
	Form Name

	18
	In Folder
	Current Folder

	19
	AccountID
	Account ID

	20
	Alignment
	Alignment

	21
	ContactID
	Contact ID

	22
	Account Manager
	Account Manager

	23
	Account
	Account 

	24
	Categories
	Categories

	25
	Selected Item
	Current Radio Button

	26
	MODIFIED
	Date item modified

	27
	MESSAGE CLASS
	IPM.Post.CustomerService

	28
	FROM
	Creator of the item

	29
	CREATED
	Date item created per store

	30
	Message
	Body of Note


Actions Form
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	Fieldname
	Form Name

	1
	Type
	Action Type

	2
	Subject
	Action

	3
	Account Name
	Account Name

	4
	Contact Name
	Contact Name

	5
	BusinessPhone
	(Body of Action)

	6
	Categories
	Categories


The following are on the Actions form but are not shown:

	
	Fieldname
	Form Name

	7
	AccountID
	Account ID

	8
	Alignment
	Alignment

	9
	ContactID
	Contact ID

	10
	CREATED
	Date item created per store

	11
	FROM
	Creator of the item

	12
	MESSAGE CLASS
	IPM.Post.Action

	13
	MODIFIED
	Date item modified

	14
	Note Type
	Note Type

	15
	OppID
	Opportunity ID


Products Form
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	Fieldname
	Form Name

	1
	Subject
	Product Name

	2
	Product Group
	Product Group

	3
	In Stock
	In Stock

	4
	Price
	Price

	5
	Discount 1-10
	Discount 1-10

	6
	Discount 10-25
	Discount 10-25

	7
	Discount 25-100
	Discount 25-100

	8
	BODY
	Product Literature


The following are on the Products form but are not shown:

	
	Fieldname
	Form Name

	9
	CREATED
	Date item created per store

	10
	FROM
	Creator of the item

	11
	MESSAGE CLASS
	IPM.Post.Product

	12
	MODIFIED
	Date item modified


Appendix B: Datastore Entity Relationships
See next page.
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Appendix C: Custom Indexing
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1. After running the “Create IPM Definitions Table” macro open the “IPM Field Definitions” table.

2. You will notice an additional column called “Indexed”.

3. Place a check mark in the “Indexed” column for the fields you want indexed.  Please note that you must check the “Indexed” column for each field in every folder you want indexed.  For example as shown in the graphic, the field “Alignment” will be indexed in the folder “Account Contacts” as shown.

4. After customizing your indexes, exit Microsoft Access and rename the SalesOutlookReports.mdb file to SalesOutlookReports.so.

5. Delete the original SalesOutlookReports.so file from the SalesOutlook root folder.

6. Copy the SalesOutlookReports.so you just worked with back to the SalesOutlook root folder.

Please note that if you do not see the “Indexed” column you are running an incorrect version of the SalesOutlookreports.so file in your SalesOutlook folder.

Appendix D: Custom Memo Fields
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1. Change the Field Type to a 99.

2. Save the Database as SalesOutlookRepotrs.so and delete then copy this file to the Outlook folder SalesOutlook.
3. Re-map the database.
Note: By default Access recognizes Outlook text fields as 255 characters in length. If you need to report on a text field that is larger then 255 characters then you will need to manually update the text field type. 
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